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1. INTRODUCCION

Arduino es una plataforma de hardware libre, basada en una placa con un microcontrolador y un entorno
de desarrollo, disefiada para facilitar el uso de la electronica en proyectos multidisciplinares. Esta
orientada a personas con perfiles creativos, con o sin experiencia previa en temas de hardware y
software, interesados en desarrollar proyectos electronicos de forma facil e intuitiva.

Grove es un set de herramientas electronicas modulares listas para ser usadas. Su principal funcion es
simplificar la tarea de trabajar con componentes electronicos sin soldaduras ni errores de conexion
posibles, facilitando al mismo tiempo el proceso de aprendizaje de manera significativa. Los modulos
Grove varian yendo desde un simple botén hasta sensores complejos, cada uno acompafiado de su propia
documentacion y ejemplos de aplicacion.

Arduino y Grove trabajando en conjunto simplifican el proceso de desarrollo de prototipos y proyectos
electrdnicos, desde su concepcion hasta su implementacion final. Ambas son herramientas de hardware
libre lo cual estimula y acelera el aprendizaje abriéndonos las puertas a la comunidad mundial de
desarrolladores de tecnologias abiertas.

Este taller esta orientado a publico en general con espiritu creativo e interesado en desarrollar sus propios
proyectos y/o productos electronicos. No es necesario tener conocimientos previos en electronica y
programacion. Este documento incluye toda la informacion necesaria para empezar a trabajar con la
placa Arduino UNO en su computadora, una guia de los sensores Grove incluidos en el kit, y la guia de los
ejercicios de aplicacion que trabajaremos en el taller.

Somos un equipo profesional compuesto por ingenieros, programadores y disefiadores dedicados a la
investigacion constante sobre nuevas maneras de fusionar arte con tecnologia. Desde el 2007 trabajamos
en proyectos de innovacion tecnoldgica, formacién académica en temas de desarrollo de software y
hardware libre y propuestas de arte contemporaneo basadas en tecnologia.

Formamos parte de una sociedad estratégica con el Centro de Innovacion y Desarrollo Emprendedor de la
Pontificia Universidad Catdlica del Per0.

Somos una empresa del grupo Ideas Multiples dedicada a la investigacion, desarrollo y divulgacion de
nuevos productos basados en plataformas abiertas de hardware y software. A través de ella queremos
poner al alcance de la comunidad los productos necesarios para poder investigar y desarrollar nuevos
prototipos y promover el hardware libre como medio de compartir el conocimiento.

Somos distribuidores oficiales de Arduino y Seeed Studio en el Pery ademas de importar diversos
componentes y complementos para roboética en general.



2. LISTA DE MATERIALES

Se trata de una tarjeta electrénica programable
basada en un microcontrolador ATmega328.
Tiene 14 pines de entradas y salidas digitales (de
las cuales 6 pueden utilizarse como ondas PWM
para producir sefales electrénicas analdgicas), 6
entradas analdgicas, un resonador ceramico de
16MHz, conexidon USB, conexion de energia
externa, un cabezal ICSP y un botdn de Reset.
Contiene todo lo que se necesita para soportar a
un microcontrolador. Para empezar a trabajar,
simplemente tiene que conectarlo a una PC a
través de un cable USB, o energizarlo con un
adaptador de corriente AC/DC, o una bateria.

La placa base Grove se conecta a una placa
Arduino, y es la base de todo el sistema Grove.
Todos los puertos de entradas y salidas estan
expuestos y adaptados a 16 conectores Grove
los cuales incluyen las entradas y salidas
digitales, analodgicas y puertos especializados
(ICSP, 12C, UART).

En la parte superior, demarcado por la linea
amarilla, se ubican los conectores de entradas
analdgicas. Las entradas analogicas se utilizan
para leer sensores analdgicos, tales como un
potencidmetro o un sensor de temperatura;
estos puertos pueden también ser utilizados
como puertos digitales.

A la derecha, demarcado por la linea roja, se
ubican los 8 conectores de entradas y salidas
digitales. Estos pueden utilizarse para leer y
controlar datos de los mdédulos Grove, tal como
el sensor de luz y los LEDs. Algunos de estos
pines pueden utilizarse como salidas de ondas
PWM (Pulse Width Modulation: Modulacion de
Ancho de Pulso), las cuales le sirven a Arduino
para controlar el movimiento de un motor de
pasos, o controlar la intensidad de un LED.
Finalmente hacia la izquierda, demarcado por la
linea verde, se ubican los conectores de
comunicacion serial 12C. Estos se usan para
conectar sensores y dispositivos mas
sofisticados como, por ejemplo, acelerometros,
modulos Bluetooth, pantallas LCD, etc.
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2. LISTA DE MATERIALES

Grove — Boton (Button)

Boton simple listo para ser usado como entrada
digital.

Grove — LED (LED Socket)

El LED es la pieza mas familiar en el aprendizaje
de sistemas electrdnicos. Se utilizan para indicar
eventos, crear efectos de luz, etc.

Grove - Sensor tactil (Touch sensor)

Sustituto para el boton simple que funciona en
base a la medida de la capacitancia. Se activa al
tocar el area circular del pad.

Grove — Zumbador (Buzzer)

Componente utilizado para generar tonos de
audio de frecuencia fija y/o variables.

Grove — Potenciometro (Rotary Angle Sensor)

Este es un potenciometro lineal rotativo de 10
kOhm (unidad resistiva) que posee un rango
activo de 300 grados.

Grove - Microfono (Sound Sensor)

Combinacién de un micréfono electret y un
amplificador ~ LM386. Cuenta con un
potenciometro que permite controlar el nivel de
entrada.




2. LISTA DE MATERIALES

Grove — LDR (Light Sensor)

El LDR es una resistencia cuyo valor depende de
la intensidad de luz que recibe. A mayor
cantidad de luz, menor resistencia.

Grove — Relé (Relay)

Componente de tipo interruptor controlado
digitalmente. Se utiliza para controlar circuitos
de mayores niveles de corriente y/o voltaje.

Sensor ultrasonido

Componente utilizado para medir distancias
basado en la emision/recepcion de ondas de
ultrasonido.

Grove — Termistor (Temperature Sensor)

El termistor es un componente cuya resistencia
varia dependiendo de la temperatura al que es
expuesto (de -40 a 120 grados Celsius).

Grove — Servo (Servomotor)

Motor de precision cuyo eje tiene un radio de
accion de 180°.

Grove — LCD (LCD-RGB Backlight)

Pantalla de tipo LCD y fondo de color ajustable.
Nos permite visualizar datos directamente sin
necesidad de una computadora.




2. LISTA DE MATERIALES

Cables de conexion entre el shield Grove y los
diversos componentes del kit.

3. ANTES DE INICIAR

Una vez reconocidos todos los materiales y teniendo todo dispuesto sobre su mesa de trabajo, debemos
hacer algunas comprobaciones previas para empezar a trabajar con el kit:

e Instalar el software Arduino IDE en su PC para poder trabajar con su placa Arduino UNO. Para
realizar la instalacion, por favor revise los documentos anexos que vienen en su memoria USB
Flash titulados Arduino — Mac.pdf y Arduino — Windows.pdf y siga los pasos segun el sistema
operativo que le corresponda.

e Conectar el shield Grove a la placa Arduino Uno.

e En el Arduino IDE ir a Herramientas -> Puerto Serial (Tools -> Serial Port) y verificar que se
reconoce la placa conectada; deberia aparecer el indicador COM# donde # corresponde a un
numero. Si no se reconoce la placa Arduino Uno desconéctela y vuélvala a conectar. Si esto no
soluciona el problema reinicie el Arduino IDE y vuelva a intentarlo. Si ain no se reconoce la
placa comuniquelo al instructor.

Luego de haber comprobado que el sistema funciona, ya estamos listos para comenzar con los
ejercicios de aplicacion.



4. EJERCICIOS DE APLICACION

Descripcion:

Parpadeo automatico de un LED.

En este ejercicio conectaremos uno de los puertos digitales del shield Grove a un
LED, el cual sera controlado por un programa que lo enciende y apaga de forma
automatica en intervalos de 1 sequndo. Los puertos digitales del Arduino pueden ser
configurados como salidas o como entradas. En este caso, el puerto estara
configurado como salida para controlar al LED. Este ejercicio nos es Util para
comprobar que la combinacion Arduino + Grove + PC estan funcionando sin
problemas.

Procedimiento:

1. Conectar la placa LED Socket al puerto D3 del shield Grove.

2. Conectar un led a los pines correspondientes de la placa LED Socket; verificar la
polaridad del led.

3. En el Arduino IDE abrir el archivo de nombre *_oa_salidaDigital_1.ino".
Cargar el programa en la placa Arduino UNO usando alguno de los siguientes
métodos:

« IraArchivo -> Cargar (File -> Load).

* Usando la combinacion de teclas Ctrl + U.

« Haciendo clic con el mouse en el botdn de carga (boton redondo ubicado a la
izquierda con la flecha apuntando hacia la derecha).

5. Verificar el funcionamiento del circuito de acuerdo a lo indicado por el instructor.

6. Con el circuito en funcionamiento desconectar la placa Relay y conectar la placa
Buzzer a la misma salida D3; verificar el funcionamiento del circuito.

7. Con el circuito en funcionamiento desconectar la placa LED Socket y conectar la
placa Relay a la misma salida D3; verificar el funcionamiento del circuito.



4. EJERCICIOS DE APLICACION

Descripcion:

Generacion de melodias simples.

Esta vez utilizaremos la placa Buzzer para escuchar una melodia generada por el
Arduino, la cual se escucha una sola vez. Para volver a escucharla es necesario
reiniciar el Arduino. Una melodia es una secuencia de notas musicales y silencios
ordenados con cierta pauta, velocidad y ritmo, tal como podremos ver en el codigo
de este ejercicio. En este caso el Arduino utiliza una salida digital para generar
sefales eléctricas vibrando a distintas frecuencias, y la placa Buzzer se encarga de
traducir esta senal eléctrica en senales audibles que el oido reconoce como notas
musicales. Para cada frecuencia corresponde una nota musical.

Procedimiento:

Conectar la placa Buzzer al puerto D3 del shield Grove.

En el Arduino IDE abrir el archivo de nombre *_o2_salidaDigital_2.ino".

Cargar el programa en la placa Arduino tal como se explicé en el ejercicio 1.
Verificar el funcionamiento del circuito de acuerdo a lo indicado por el instructor.

B w N R

Descripcion:

Encendido y apagado de un LED de forma manual con un boton.

Esta vez introduciremos el uso de los puertos digitales del Arduino como entradas
digitales. Una entrada digital permite introducir sefales de dispositivos electronicos
-como botones, switches, pulsadores, sensores magnéticos, etc.- para controlar
acciones con el Arduino. En este ejemplo utilizaremos la placa Button y la placa
Touch para controlar el encendido y apagado de un LED.

Procedimiento:

1. Conectar la placa Button al puerto D2 del shield Grove.
2. Conectar la placa LED Socket al puerto D3 del shield Grove.



4. EJERCICIOS DE APLICACION

3. Conectar un led a los pines correspondientes de la placa LED Socket; verificar la
polaridad del led.

En el Arduino IDE abrir el archivo de nombre "_o3_entradaDigital.ino".

Cargar el programa en la placa Arduino tal como se explico en el ejercicio 1.
Verificar el funcionamiento del circuito de acuerdo a lo indicado por el instructor.
Con el circuito en funcionamiento desconectar la placa Button y conectar la placa
Touch a la misma salida D2; verificar el funcionamiento del circuito.

N oo b

Descripcion:

Lectura del nivel de sefal de sensores analogicos.

En este ejercicio introduciremos el uso del potencidmetro como sensor analdgico, y
de la herramienta monitor serial para leer el valor del potencidmetro conectado al
shield Grove. Al girar la perilla del potenciémetro, podremos ver que varia el valor
numérico que se muestra en el monitor serial; a menor angulo, menor valor
numeérico y viceversa. Los sensores analdgicos son sensores que producen senales
continuas y variables, como por ejemplo un potenciometro (sensor de giro manual),
un sensor de temperatura, de nivel de sonido, de nivel de luz, entre otros. Los
sensores digitales (botones, switches, etc.) solo producen senales de ON/OFF,
mientras que los sensores analogicos producen una variedad de niveles de sefal;
ambos tienen naturalezas distintas, y por ello sus comportamientos y aplicaciones
también lo son.

Procedimiento:

Conectar la placa Rotary Angle al puerto Ao del shield Grove.

En el Arduino IDE abrir el archivo de nombre "_o4_entradaAnaloga_1.ino".
Cargar el programa en la placa Arduino tal como se explico en el ejercicio 1.

En el Arduino IDE abrir el monitor serial usando alguno de los siguientes
métodos:

A W N R

 IraHerramientas -> Monitor Serial (Tools -> Serial Monitor).

* Usando la combinacion de teclas Ctrl + Shift + M.

e Haciendo clic con el mouse en el boton del monitor serial (boton cuadrado
ubicado a la derecha con el icono de lupa).



4. EJERCICIOS DE APLICACION

Verificar el funcionamiento del circuito de acuerdo a lo indicado por el instructor.
6. Con el circuito en funcionamiento desconectar la placa Rotary Angle y conectar la
placa Light Sensor a la misma entrada Ao; verificar el funcionamiento del circuito.
7. Con el circuito en funcionamiento desconectar la placa Light Sensor y conectar la
placa Sound Sensor a la misma entrada Ao; verificar el funcionamiento del
circuito.

Descripcion:

Lectura del nivel de sefal de un sensor analogico complejo.

Muchas veces los sensores analdgicos no tienen un comportamiento lineal, algunos
de ellos podrian tener un comportamiento exponencial, logaritmico, geométrico,
etc. Tal es el caso del sensor de temperatura, el cual tiene un comportamiento
complejo que necesita de una formula de conversion para poder determinar el valor
exacto de la temperatura. Este ejercicio es un ejemplo de cémo adaptar el valor de
entrada de un sensor no lineal con técnicas de software (uso de variables, funciones
matematicas, etc.) para obtener valores de salida mas familiares para un usuario que
no necesita entender las complejidades del mundo digital.

Procedimiento:

Conectar la placa Temperature al puerto Ao del shield Grove.

En el Arduino IDE abrir el archivo de nombre *_os_entradaAnaloga_z2.ino".
Cargar el programa en la placa Arduino tal como se explico en el ejercicio 1.

Abrir el monitor serial en el Arduino IDE tal como se explicé en el ejercicio 4.
Verificar el funcionamiento del circuito de acuerdo a lo indicado por el instructor.

e W op



4. EJERCICIOS DE APLICACION

Descripcion:

Encendido y apagado de un LED de forma progresiva y automatica.

En el primer ejercicio introducimos el control del encendido y apagado de un LED,
pero ;como lograr que el LED varie su intensidad de luz de forma progresiva? Para
esta aplicacion introduciremos el uso de sefiales PWM (Pulse Width Modulation, o
Modulacion de Ancho de Pulso). Una sefal PWM es una sefal digital variable que se
comporta como una salida analdgica y nos permite controlar dispositivos de forma
paulatina, como por ejemplo la potencia de la intensidad de un LED, el giro de un
motor, el volumen de un sonido, etc. Arduino tiene ciertos puertos digitales
asignados con la capacidad para generar este tipo de sefiales PWM.

Procedimiento:

1. Conectar la placa LED Socket al puerto D3 del shield Grove.

Conectar un led a los pines correspondientes de la placa LED Socket; verificar la
polaridad del led.

En el Arduino IDE abrir el archivo de nombre ™ _o06_salidaPWM.ino".

Cargar el programa en la placa Arduino tal como se explico en el ejercicio 1.
Verificar el funcionamiento del circuito de acuerdo a lo indicado por el instructor.
Con el circuito en funcionamiento desconectar la placa LED Socket y conectar la
placa Buzzer a la misma salida D3; verificar el funcionamiento del circuito.

N
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Descripcion:

Control de giro de un servomotor de forma automatica.

En este ejercicio aplicaremos una sefial PWM para controlar el giro de un
servomotor de o a 180 grados y viceversa. Un servomotor es un tipo de motor
eléctrico con control de posicion angular, el modelo incluido en el kit Grove tiene un
rango de movimiento limitado a 180 grados, controlado de forma digital y que es
muy popular en aplicaciones robdticas.

10



4. EJERCICIOS DE APLICACION

Procedimiento:

Conectar el Servo al puerto D3 del shield Grove.

Acoplar al eje del Servo uno de los brazos de accesorio incluidos.

En el Arduino IDE abrir el archivo de nombre “_o7_servoMotor.ino”.

Cargar el programa en la placa Arduino tal como se explico en el ejercicio 1.
Verificar el funcionamiento del circuito de acuerdo a lo indicado por el instructor.

e W op

Descripcion:

Deteccion de distancias con el sensor de ultrasonido.

Este sensor esta basado en un sistema de emision y recepcion de pulsos de
ultrasonidoTomando como referencia el tiempo transcurrido entre la emision vy
recepcion de un pulso de senal se calcula la distancia fisica entre el sensor y el
objeto. Utiliza el mismo principio que los delfines y los murciélagos para calcular su
posicion en el espacio. Para este ejercicio, hemos limitado la distancia maxima de
medicion a 200cm la cual sera mostrada en el monitor serial.

Procedimiento:

Conectar el cable especial del sensor ultrasonido al puerto D7 del shield Grove.
Conectar el pin Trigger del ultrasonido al cable de color blanco.

Conectar el pin Echo del ultrasonido al cable de color amarillo.

Conectar el pin VCC del ultrasonido al cable de color rojo.

Conectar el pin GND del ultrasonido al cable de color negro.

En el Arduino IDE abrir el archivo de nombre “_o8_ultraSonido.ino".

Cargar el programa en la placa Arduino tal como se explico en el ejercicio 1.
Verificar el funcionamiento del circuito de acuerdo a lo indicado por el instructor.

ON OV~ W N P
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4. EJERCICIOS DE APLICACION

Descripcion:

Uso de la pantalla LCD para visualizar datos.

El kit Grove incluye una pantalla LCD que es muy Util para visualizar informacion de
sensores y dispositivos controlados por el Arduino. Gracias a esta pantalla, podemos
prescindir del uso de la PC y el monitor serial al visualizar datos especificos. Esto se
traduce en portabilidad y practicidad al disefiar sistemas electrénicos.

Procedimiento:

Conectar la placa Grove-LCD al cualquier puerto 12C del shield Grove.

En el Arduino IDE abrir el archivo de nombre ™_og_pantallaLCD.ino".

Cargar el programa en la placa Arduino tal como se explicé en el ejercicio 1.
Verificar el funcionamiento del circuito de acuerdo a lo indicado por el instructor.

S WP

Descripcion:

Theremin de luz.

A partir de este ejercicio, empezaremos a aplicar los conocimientos aprendidos
hasta ahora para crear pequenos proyectos combinando algunos de los sensores y/o
actuadores incluidos en el kit Grove. Un theremin es un instrumento musical
eléctrico que a través de una antena, detecta la posicion de la mano del musico,
produciendo notas musicales segun la variacion de esta distancia. De forma similar,
este proyecto produce notas musicales al variar el nivel de intensidad de luz que
incide en el sensor de luz. Mientras menor sea la cantidad de luz detectada, menor
sera la frecuencia de la nota musical, y viceversa.

Procedimiento:
1. Conectar la placa Light Sensor al puerto Ao del shield Grove.

2. Conectar la placa Buzzer al puerto D3 del shield Grove.
3. Enel Arduino IDE abrir el archivo de nombre™_10_thereminLuz.ino".

12



4. EJERCICIOS DE APLICACION

4. Cargar el programa en la placa Arduino tal como se explico en el ejercicio 1.
5. Verificar el funcionamiento del circuito de acuerdo a lo indicado por el instructor.

Descripcion:
Control manual de la intensidad luminosa de un LED.
En este ejercicio, utilizaremos el potenciometro para regular manualmente la

potencia de la luz de un LED a través de la variacion de la onda PWM que lo
alimenta.

Procedimiento:

Conectar la placa LED Socket al puerto D3 del shield Grove.

2. Conectar un led a los pines correspondientes de la placa LED Socket; verificar la
polaridad del led.

3. Conectar la placa Rotary Angle al puerto Ao del shield Grove.

4. En el Arduino IDE abrir el archivo de nombre™_11_controlLed_1.ino".

5. Cargar el programa en la placa Arduino tal como se explico en el ejercicio 1.

6. Abrir el monitor serial en el Arduino IDE tal como se explico en el ejercicio 4.

Verificar el funcionamiento del circuito de acuerdo a lo indicado por el instructor.

Descripcion:
Control por distancia de la intensidad luminosa de un LED.
Este ejercicio es una variacion del ejercicio anterior, pero en vez de utilizar el

potenciometro para variar la onda PWM utilizaremos el sensor de ultrasonido.

Procedimiento:

1. Conectar el cable especial del sensor ultrasonido al puerto D7 del shield Grove.

13
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4. EJERCICIOS DE APLICACION

Conectar el pin Trigger del ultrasonido al cable de color blanco.

Conectar el pin Echo del ultrasonido al cable de color amarillo.

Conectar el pin VCC del ultrasonido al cable de color rojo.

Conectar el pin GND del ultrasonido al cable de color negro.

Conectar la placa LED Socket al puerto D3 del shield Grove.

Conectar la placa Grove-LCD al cualquier puerto 12C del shield Grove.

En el Arduino IDE abrir el archivo de nombre ™_12_controlLed_2.ino".

. Cargar el programa en la placa Arduino tal como se explico en el ejercicio 1.

10. Verificar el funcionamiento del circuito de acuerdo a lo indicado por el instructor.

Descripcion:

Control manual de la posicion de un servomotor.
Esta vez utilizaremos el potenciometro para regular el angulo de posicion de un
servomotor a través de la variacion de la onda PWM que lo alimenta.

Procedimiento:

o s wnN kB

Conectar el Servo al puerto D3 del shield Grove.

Conectar la placa Rotary Angle al puerto Ao del shield Grove.

Conectar la placa Grove-LCD a cualquier puerto 12C del shield Grove.

En el Arduino IDE abrir el archivo de nombre _13_controlServo_1.ino".

Cargar el programa en la placa Arduino tal como se explicd en el ejercicio 1.
Verificar el funcionamiento del circuito de acuerdo a lo indicado por el instructor.

Descripcion:

Control por distancia de la posicion de un servomotor.
Esta vez controlaremos el angulo de giro del servomotor con el sensor de
ultrasonido. El principio es similar al ejercicio anterior, pero considerando que el

14



4. EJERCICIOS DE APLICACION

rango de distancias para controlar el giro del motor es de o a 30cm siendo este valor
modificable.

Procedimiento:

Conectar el Servo al puerto D3 del shield Grove.

Conectar la placa Grove-LCD a cualquier puerto 12C del shield Grove.

Conectar el cable especial del sensor ultrasonido al puerto D7 del shield Grove.
Conectar el pin Trigger del ultrasonido al cable de color blanco.

Conectar el pin Echo del ultrasonido al cable de color amarillo.

Conectar el pin VCC del ultrasonido al cable de color rojo.

Conectar el pin GND del ultrasonido al cable de color negro.

En el Arduino IDE abrir el archivo de nombre “_14_controlServo_2.ino".

Cargar el programa en la placa Arduino tal como se explicd en el ejercicio 1.

10. Verificar el funcionamiento del circuito de acuerdo a lo indicado por el instructor.

©oONOGH WP

Descripcion:

Control por distancia de un relé.

Para este ejercicio se activard y desactivara un relé dependiendo de la distancia de
un objeto a un sensor ultrasonido. Tomando como base esta distancia se podran
generar mensajes predeterminados en una pantalla LCD y asi mismo activar un
dispositivo externo, como una alarma, en caso sea necesario.

Procedimiento:

Conectar la placa Relay al puerto D2 del shield Grove.

Conectar la placa Grove-LCD a cualquier puerto 12C del shield Grove.

Conectar el cable especial del sensor ultrasonido al puerto D7 del shield Grove.
Conectar el pin Trigger del ultrasonido al cable de color blanco.

Conectar el pin Echo del ultrasonido al cable de color amarillo.

Conectar el pin VCC del ultrasonido al cable de color rojo.

Conectar el pin GND del ultrasonido al cable de color negro.

En el Arduino IDE abrir el archivo de nombre “_15_controlPorDistancia.ino”.
Cargar el programa en la placa Arduino tal como se explico en el ejercicio 1.

10. Verificar el funcionamiento del circuito de acuerdo a lo indicado por el instructor.

©CENAG WP

15



4. EJERCICIOS DE APLICACION

Descripcion:

Activacion de un circuito externo a través de eventos sonoros.

En este ejercicio utilizaremos el sensor de sonido para conmutar la placa Relay que
servira de puente para alimentar un circuito externo de mayor potencia. Para activar
el circuito de mayor potencia sera necesario generar un sonido cuya intensidad sea
mayor a un valor umbral determinado por software. Para desactivar la alimentacion
es necesario generar nuevamente un sonido de las mismas caracteristicas. El led nos
indica que el sistema esta listo para recibir un nuevo impulso sonoro. Este circuito de
mayor potencia podria estar conectado al sistema de corriente doméstica (220 VAC)
y alimentar dispositivos de bajo consumo como lamparas, cargadores de celular,
equipos de sonido, etc.

Procedimiento:

Conectar la placa Sound Sensor al puerto Ao del shield Grove.

Conectar la placa Relay al puerto D2 del shield Grove.

Conectar la placa Grove-LCD a cualquier puerto 12C del shield Grove.

Conectar la placa LED Socket al puerto D3 del shield Grove.

Conectar un led a los pines correspondientes de la placa LED Socket; verificar la
polaridad del led.

En el Arduino IDE abrir el archivo de nombre™_16_controlPorSonido.ino”.
Cargar el programa en la placa Arduino tal como se explico en el ejercicio 1.

8. Verificar el funcionamiento del circuito de acuerdo a lo indicado por el instructor.
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5. CONVERSATORIO

¢Y ahora? Una vez que ya hemos aprendido el funcionamiento basico de los componentes del kit Grove,
asi como nuestras primeras nociones en lo que a programacion se refiere, es hora de darse tiempo para
un respiro. Aprovechemos esta pausa para exponer nuestras ideas y propuestas, lo que quisiéramos hacer
en adelante, las nuevas combinaciones que se nos ocurren, lo que aun no hemos visto pero quisiéramos
very un largo etcétera.

Demos rienda suelta a nuestro espiritu creativo y busquemos soluciones en conjunto, de manera que
podamos complementar nuestras habilidades y talentos. Lo que el artista necesita puede estar alojado en
la mente del ingeniero y viceversa.

No olvidemos que ya hemos dado el primer paso, nuestro ingreso honorario, a una comunidad de
desarrolladores que se mantiene activa dia a dia gracias al perfil innovador y colaborativo de cada uno de
sus miembros. A manera de inspiracion les sugerimos tomar en cuenta esta breve lista de paginas web
con informacion sobre electrdnica, programacion y tutoriales de disefio e implementacion de productos
de tipo hdgalo usted mismo (DIY):

www.adafruit.com
www.sparkfun.com
www.instructables.com
www.makezine.com

Adicionalmente nuestras puertas siempre estaran abiertas para aquellos que deseen profundizar mas sus
conocimientos relacionados a temas de desarrollo, hardware & software libre, arte en general y afines.
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